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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.
 

 
CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

 

 
NOTICE
indicates that an unintended result or situation can occur if the relevant information is not taken into account.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY

Order number: Printout of the Online Help
Ⓟ 12/2011 Technical data subject to change

Copyright © Siemens AG 2011.
All rights reserved
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Security information 1
Safe operation of a plant

To ensure safe operation of a plant, you have to take suitable security measures that also 
include IT security (e.g. network segmentation). More information on Industrial Security is 
available on the Internet (www.siemens.com/industrialsecurity).

 

 NOTICE

Various passwords are set by default in WinCC. For security reasons, you should change 
these passwords.
● For the Sm@rtServer and for the integrated Web server, the default password is "100".
● The user password "100" is set by default for the "Administrator".
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General information 2
Contents

General information that could not be included in the manual or Online Help.

Starting ProTool after installing WinCC flexible
ProTool cannot be started from STEP 7 for integrated projects after the installation of 
WinCC flexible. This can be remedied by running ProTool from the Windows Start menu after 
the installation of WinCC flexible. You will then be able to start ProTool from STEP 7 again.   

Microsoft Windows update
When WinCC flexible and WinCC flexible Runtime are installed, all required components of 
the operating system that are not present at the time of installation will be added. After having 
installed WinCC flexible, we highly recommend running "Microsoft Windows Update" to check 
for new security patches.

Display of HTML pages in Pocket Internet Explorer
The Pocket Internet Explorer of HMI panels is only released for simple HTML pages based on 
HTML 3.0 standard.

Using multiple screens
The operating system function used to visualize the screen content on several monitors 
(Control Panel > Display > Settings) has not been approved for WinCC flexible.

"Save as" in case of several WinCC flexible instances
"Save as" in the source may result in errors after copy-and-paste operation between instances. 

Entries in the Windows event display by WinCC flexible     
Warnings that are caused by the Microsoft SQL Server or the Automation License Manager 
can occur in the Windows event display. These warnings are not critical and do not impair the 
functionality of WinCC flexible.

Working on external media
Working on external media such as network drives or USB media can decrease performance.

We recommend that projects be edited on the local hard disk. 
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WinAC MP: Timeout error when printing a log
If you disable the headers and footers in a log, a timeout error may occur when the log is printed 
via USB.

In order to avoid the error, insert empty headers and footers.

Error message "User Instance Mode" when starting WinCC flexible
If you have installed SQL Server 2005 Express, an error message may be generated at the 
start of WinCC flexible indicating that "User Instance Mode" could not be started.

We recommend a restart.

Starting the Microsoft SQL Server 2005 Express Instance
The WinCC flexible instance of Microsoft SQL Server no longer starts after the PC was 
accessed by means of Remote Desktop. Restart the computer.

A corresponding hotfix is available from Microsoft for this error: KB896613

User data of Microsoft SQL Server 2005 Express Edition
A project could not be created or opened and an error message was output. The reason can 
be damaged user data of Microsoft SQL Server 2005 Express Edition.     

Remedy:

1. Exit WinCC flexible 2008.

2. Closes the Start Center.

3. Open Windows Explorer and delete the following directory.
In Windows XP:
"%USERPROFILE%\Local Settings\Application Data\Microsoft\Microsoft SQL Server Data
\WINCCFLEXEXPRESS" 
If using Windows 7:
"%USERPROFILE%\AppData\Local\Microsoft\Microsoft SQL Server Data
\WinCCFLEXEXPRESS"

Getting Started - WinCC flexible 2008 
The Getting Started for WinCC flexible is based on version 2008. This means certain 
descriptions may not match the current version 2008 SP3. This statement is particularly true 
for the description of WinAC MP.

Getting Started Options 
The documentation on "Getting Started Options" mentions the Microsoft SOAP Toolkit 3.0 as 
a prerequisite. As of version 2008 of WinCC flexible, the installation of the Microsoft SOAP 
Toolkit 3.0 is no longer necessary. 

General information
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Turkish operating system: Folder names
If the folder name includes an "i", you may experience some problems with Turkish operating 
systems, such as C:\temp_i. 

Data backup via USB
"Backup/Restore" in the Control Panel has been approved for use via USB for the following 
HMI devices:         

● MP 177 - USB stick with 2 GB capacity only

● TP 177B 4" - USB stick with 2 GB capacity only

● MP 277

● Mobile Panel 277

● Mobile Panel 277 IWLAN

● Mobile Panel 277 IWLAN V2

● MP 377

See also
General Information (Page 25)

General information (Page 39)

General information (Page 47)

General information
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Installation/removal 3
Contents

Information on installation not included in the manual or Online Help.

Microsoft SQL server cannot be installed
If the installation of the Microsoft SQL server is not possible, please check the "Automatic 
startup type" of the "Service" on your computer. "Deactivated" is not allowed to be set at the 
"Automatic startup type". Due to a restriction of the Microsoft setup, this service is a 
requirement for a successful installation.

Changing the license   
In order to carry out a license change, terminate WinCC flexible Auto Start. After you have 
carried out the change successfully, you can re-activate WinCC flexible Auto Start.

Port activation for ALM
Port activation takes place automatically during installation of WinCC flexible. You can activate 
or deactivate the usage of port activation.     

Release of directories and programs
Installation grants all users rights to write to the following directories under 
"%ALLUSERSPROFILE%\Application data":

● "SIEMENS AG\SIMATIC WinCC flexible"

● "SIEMENS AG\SIMATIC WinCC flexible 2008\Caches"

You need these directories to execute the central logs for WinCC flexible.

Installation enables the following programs in the Windows firewall:

● SIMATIC WinCC flexible 2008 Application

● SIMATIC WinCC flexible 2008 Trace Server

● Automation License Manager    

Installation of SIMATIC products
Disable the "WinCC flexible Start Center" before you start installation of a SIMATIC 
product.   
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Installation Microsoft SOAP Toolkit 3.0
As of version 2008 of WinCC flexible, the installation of the Microsoft SOAP Toolkit 3.0 is no 
longer necessary.

WinCC flexible integrated in SIMOTION SCOUT
The following requirements have to be met to ensure trouble-free operation of WinCC flexible 
integrated in SIMOTION SCOUT:

● Work memory: 4 GB

● Processor: Dual Core

Review the additional information in the online help in all cases. The section "SIMOTION 
SCOUT project data" describes important performance features of integrated operation.

Installation sequence for integrated operation in SIMOTION SCOUT
Install the software in the following sequence. 

Integrated operation will be ensured without any problems when you observe this installation 
sequence.

1. Step 7

2. SIMOTION SCOUT

3. WinCC flexible

Refer to the compatibility table provided with the SIMOTION SCOUT CD.

Audit Viewer
The Audit Viewer has been released

● for operating systems in the languages German, English, French, Italian and Spanish

● for an MUI operating system in one of the languages listed above

● for evaluation of an Audit Trail generated in one of the languages listed above.

The Audit Viewer V7.0.3 is located in the following directory on the WinCC flexible product 
DVD: /Support/Audit Viewer/Setup.

ProTool after uninstalling WinCC flexible
If you uninstall WinCC flexible, ProTool will no longer function.       

Remedy:

1. Uninstall ProTool.

2. Reinstall ProTool.

3. Open Control Panel.

4. Double-click on "Software".

5. Select the "SIMATIC STEP 7" entry.

Installation/removal
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6. Click "Change".

7. In the installation dialog, select "Repair program".

Audit Trail and Log with Checksum
Before you update WinCC flexible with a new Service Pack or by a new version, you will have 
to exit and save the Audit Trail or the logs with checksum. After updating WinCC flexible, Audit 
Trail or the logs with checksum will be continued with new files. 

The new version of WinCC flexible will start the logs at a defined state.

Error message during installation
You may occasionally see the error message "S7oiehsx.exe - Error in application" during 
installation of WinCC flexible.     

Confirm the error message with "OK." The error message does not affect operation of WinCC 
flexible. 

Installation of WinCC flexible 2008 SP3
Close all open SIMATIC applications before you start installation of WinCC flexible 2008 SP3.

Changing the installation
If you have installed WinCC flexible 2008, or WinCC flexible 2008 SP1, or WinCC flexible 2008 
SP2, update your system with WinCC flexible 2008 SP3. Changes to the installed version, 
however, are not possible.

Proceed as follows to change the existing installation and add components, such as integration 
into Step7 or adding languages:   

1. Open "Control Panel > Add or remove programs".

2. Select "WinCC flexible 2008 SP3."

3. Click "Change". The WinCC flexible InstallShield Wizard opens.

4. Change the installation to meet your requirements.

5. Finish the installation.

See also
24435650 (http://support.automation.siemens.com/WW/view/en/24435650)

Installation/removal
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Special features with Windows 7 4
Contents

General information that could not be included in the manual or Online Help.

Permitted characters
WinCC flexible supports the full ASCII character set. We advise users, however, to refrain from 
using localized special characters. You should in particular refrain from using these special 
characters in the names of objects used in scripts.

New entries in the Windows Start menu
Under Windows 7, the entries of the SIMATIC product group are available under:

"Start > All Programs > Siemens Automation".

Slow response of screen keyboard and SmartServer
The following programs start and respond rather slowly under Windows 7:

● Screen keyboard Microsoft OSK and HMI TouchInputPC

● SmartServer: Key combination <Ctrl+Alt+Del> during logon

The delay is caused by the Internet certification check with callback.

Remedy:

The following files are available in the Support\Windows7\CRL_Check directory on your 
product DVD:

● DisableCRLCheck_LocalSystem.cmd

● DisableCRLCheck_CurrentUser.cmd

     
 

 NOTICE

The certificate check on callback will be disabled for all users or computers. To restore the 
default settings, run the following files from the product DVD:

\Support\Windows7\CRL_Check 

Files:
● RestoreDefaults_LocalSystem.cmd
● RestoreDefaults_CurrentUser.cmd
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1. Execute the file "DisableCRLCheck__LocalSystem.cmd" with administrator rights. To do 
so, enter the command "Run as administrator" in the shortcut menu of the file.

2. Restart the computer.

Proceed as follows if the problem persists:

1. Execute the file "DisableCRLCheck__CurrentUser.cmd" with user rights. Double-click the 
file.

2. Restart the computer.

PC Runtime: Communication drivers under Windows 7 operating system
The following communication drivers for PC Runtime are not supported under Windows 7:

● SIMATIC S5 DP

● SIMATIC 500/505 DP      

S7DOS V8: Missing write permissions in the registry
To set up a connection to the PLC with WinCC flexible Runtime, it may be necessary that 
Runtime changes the connection settings in the registry. Any user of WinCC flexible Runtime 
without write permission for the registry receives a system message. For write permission to 
the registry, users must be members of the group "Siemens TIA Engineer" created by 
S7DOS.   

System function "SetDaylightSaving"
The system function "SetDaylightSaving" is not supported for PC-based HMI devices under 
Windows 7.     

Creating a new graphic object as OLE object
The entry "Bitmap Image" is no longer available under Windows 7. Use "Paintbrush Picture" 
instead.   

Logs and recipe data on a server with Windows 7
The following HMI devices are not suitable for storing logs and recipe data on a server with 
Windows 7:     

● OP 77B

● TP 170B, OP 170B

● TP 177B, OP 177B

● TP 270, OP 270

● TP 277, OP 277

● MP 270

● MP 370

Special features with Windows 7
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● Mobile Panel 170

● Mobile Panel 177

Stopping the Sm@rtServer
Sm@rtServer always runs as a service in Windows 7. This means you cannot stop the 
Sm@rtServer in Runtime with the Notification Area in the taskbar. You have the following 
options to stop the Sm@rtServer:

● Exit the system function "ControlSmartServer"
Configure the system function "ControlSmartServer" to a button, for example. At the system 
function select the "Stop" mode. Stop the Sm@rtServer by clicking the button in Runtime.

● Stopping the Sm@rtServers with the Control Panel:
Open the "WinCC flexible Internet Settings" in the Control Panel and activate the "Remote" 
tab. Click "Stop". The Sm@rtServer will be stopped.

● Stopping the Sm@rtServer with Runtime:
Open the "WinCC flexible Internet Settings" in the Control Panel and activate the "Remote" 
tab. Activate the option "Close with Runtime". The Sm@rtServer will be stopped when 
Runtime is stopped.

Working with standard user rights
If you work with standard user rights under Windows 7, do not disable the "User Account 
Control" (UAC).

The "User Account Control" is enabled by default under Windows 7.

You can find additional information about "User Account Control" in Windows 7 Help.

Serial OS update with an MP 377
If you run a serial update with an MP 377, you may sporadically encounter a connection abort 
when using Windows 7.

If the connection aborts, run the "Reset to factory settings" function.

Use Ethernet or USB for the connection when updating the OS.

Printing project data
When you print project data, WinCC flexible may sometimes crash under Windows 7. Contact 
Customer Support if this problem occurs.     

Set PG/PC interface
To set up modules with the application "Set PG/PC interface", you need additional rights under 
Windows7.   

The administrator will have to add each user who is permitted to make changes to the SIMATIC 
configuration to the user group "Siemens TIA Engineer". 

Special features with Windows 7
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Teleservice in Windows 7
Teleservice for Windows 7 is not approved. 

Special features with Windows 7
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Special features for languages 5
Contents

Special features not covered in the manual or Online Help.

Display of Asian fonts in Runtime
If you use fonts that are not the standard fonts of WinCC flexible for the project configuration, 
display problems may occur at some HMI devices.

Use only the standard fonts or extend the collection of fonts on the HMI device to include those 
fonts used in the project. 

Error during import in WinCC flexible of national letters and special characters from ProAgent
If you have imported ProAgent data or ALARM-S alarms with national letters and special 
characters from WinCC flexible 2007 Hotfix 5 or earlier into an integrated project and migrated 
to WinCC flexible 2008 with this project, errors may occur when importing the national letters 
and special characters.

Remedy:
1. Disable the connections to the respective S7 programs with national letters and special 

characters for ProAgent data or ALARM-S alarms.

2. Select the "Delete Temporary Files" command from the "Tools" menu.

3. Reactivate the connections you have deactivated in step 1.

4. Select the desired ProAgent units in the "ProAgent" editor.
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Migration 6
Contents

The migration of projects is not supported in WinCC flexible 2008 SP3.
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WinCC flexible 2008 SP3 Micro 7
Contents

Specific information on WinCC flexible 2008 SP3 Micro that could not be included in the online 
help or manual. 
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Engineering System 8
8.1 General Information

 Contents
General information on WinCC flexible that could not be included in the manual or online help.

Logging on network drives
We do not recommend that you log alarms, tags, and Audit Trail directly on a network drive. 
Power supply can be interrupted at any time. This means there is no guarantee for a reliable 
operation of logs and audit trails.

We recommend you save the logs and audit trails on your local hard drive or a local storage 
card. Use the system function "ArchiveLogFile" to save the logs or the audit trail long-term on 
a network drive. This step ensures reliable operation.

Security updates
When WinCC flexible is installed, all required components of the operating system that are not 
available yet are installed. After you have installed WinCC flexible, run "Microsoft Windows 
Update" to check for new security patches.   

Importing project texts
The > < ' and & characters may not be used in an import file.   

Project Wizard 
When a new project is created using the Project Wizard, it is possible to have a header created 
in the screen template. The header is not supported by OP 73micro, TP 177micro, OP 73, 
OP 77A and TP 177A HMI devices.  

Differences in the visualization of screen elements on the HMI device
The representation of screen elements (symbol library, images or texts) on the configuration 
computer can deviate from the representation on the HMI device. The deviation can be caused 
by:

● The display technology

● Differences in the resolution at the configuration computer and the HMI device

You should always check the final layout on the HMI device.
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Changing the online help language
If the online help system crashes when the language is changed, check the version of the 
"hhctrl.ocx" file in the "system32" subdirectory of the installation directory of the operating 
system. If the file version is older than V5.2.3735.0, download a newer version from http://
msdn.microsoft.com/library/default.asp?url=/library/en-us/htmlhelp/html/
hwMicrosoftHTMLHelpDownloads.asp. 

User dictionaries
User dictionaries are read-only if you open multiple instances of WinCC flexible.  

Replacing HMI devices with DP configuration
The configuration for direct keys is not altered when you replace an HMI device with DP 
configuration. The HMI device cannot be operated in Runtime if the direct-key configuration is 
incorrect, for example, when using an incompatible DP slave. Always check the direct-key 
configuration and the existence of appropriate DP modules in HW Config when you replace 
an HMI device.   

Graphics are not displayed correctly when 277 devices are used:
You have configured several HMI devices in WinCC flexible. One of these HMI devices is one 
of the new 277 devices. The different depths of color can cause an error in the screens they 
contain.

The error causes the following situations:

1. Graphics with 16-bit color depth are transferred for the HMI device with 8-bit color depth.
The cactus screen is represented as the default screen, rather than the actual graphic.

2. Graphics with 8-bit color depth are transferred for the HMI device with 16-bit color depth.
The actual graphic appears rather fuzzy.

Workaround:

As a workaround, you can correct the incorrectly transferred HMI device by switching the 
device. 

You can then switch back to the original HMI device. 

Generate the project for the HMI device once more and transfer this to the panel. 

You may have to repeat this step for every HMI device that is not displaying the graphics 
correctly.

Project texts: Fields in the function "Automatic Compilation"
Contrary to statements made in the online help, the function "Automatic Compilation" is 
available even if the text for compilation includes tags or text lists. If the fields have a different 
format in the source language, then the fields will be displayed first in the target language 
followed by the texts separated by spaces.

Engineering System
8.1 General Information
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Starting the simulator
If a simulation is already running in the background, you may not be able to always start another 
instance of the simulator correctly. 

Printing reports
If you want to print a report, you should first set the online language to the logging language.

Report: Printing the Audit Trail
If you want to print an Audit Trail in Runtime, Audit logging must be stopped. No operations 
related to the FDA-conform process can be active as long as an Audit Trail is being printed.

Audit Trail
Prior to commissioning check that the printout of the Audit Trail is complete with the selected 
print settings using the configured font and size. 

In particular check the first line of an Audit Trail entry consisting of "Data record ID", "Time 
stamp", "DeltaZuUTC" and "UserID".  

Moving tags for address multiplexing
You have created the tags Tag_1 and Tag_2 for address multiplexing. Tag_2 is the address 
of the tag Tag_2. 

Create a folder to organize the tags. Move Tag_2 to this folder. To refresh the display in the 
"Tags" editor, close and reopen the editor.

Modicon MODBUS TCP/IP: Number of elements per array
For a tag with "Modicon MODBUS TCP/IP" connection, the maximum number of elements per 
array is 50.

 

See also
Integration in STEP 7 (Page 54)

Engineering System
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8.2 Projects

Contents
Information on working with projects which is no longer included in the manual or the online 
help.

Managing projects in Windows Explorer
WinCC flexible creates a project database on the hard disk when you save a project. The 
project database is stored in the Windows file manager with the extension *.hmi. A log file 
(*_log.ldf) is stored for each project database. Consistency of data cannot be guaranteed 
without this log file.

The project database can be moved, copied and deleted together with the corresponding log 
file in the Windows Explorer, as you are used to with other files. However, ensure that the 
database and the log file are not separated from each other during copying and moving.

For further information, refer to Working with Projects in section "Managing projects in the 
Windows Explorer."

Opening integrated projects   
When a WinCC flexible project originating from an older version is opened for the first time 
with WinCC flexible 2008, conversion starts by default. The conversion may require some time 
and, in the case of very large projects, may also require some hours.

If the project was opened directly from the SIMATIC Manager, the conversion progress is 
shown by means of a display. In the case of very large progress, this does not show the actual 
course. In this case the CPU utilization of the computer indicates that conversion is still running.

The conversion process should not be aborted. 

Access problems at project files 
If configuration files cannot be copied/moved or "Save As" is not possible or other access 
problems occur, the following solution can be tried:

Open and close the project and then carry out the failed action again - if appropriate in 
connection with a previous rebooting of the computer.

"Save as" to external USB media
If you save a project to external media with the "Save as" command, it may take a few minutes.

We recommend saving the project locally and then copying it to an external data storage device 
using the Windows Explorer. 

Incorrect display of symbolic IO fields after conversion
When a project is converted to a later version of WinCC flexible, any symbolic IO fields included 
in the project will be displayed incompletely. 

Engineering System
8.2 Projects
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Delete the incorrect symbolic IO field and reconfigure the symbolic IO field.

Engineering System
8.2 Projects
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8.3 Recipes

Contents
Information on working with recipes which is no longer included in the manual or the Online 
Help.

OP 77A, TP 177A and Basic Panels: Reaction of the buttons to page changes
The "Save" dialog with its "Yes", "No" and "Cancel" buttons is displayed if you edit a recipe 
data record and trigger a page change without having saved the recipe data record. The "No" 
and "Cancel" buttons trigger the same reaction: The changes you have made to the recipe 
data record will not be saved.

OP 77A, TP 177A and Basic Panels: Overwriting changed values
If you change the values of a recipe data record in the recipe view while transferring a recipe 
data record between PLC and the HMI device, the altered values will be overwritten in the 
recipe view. 

Disabling synchronization of tags in the process picture
Clear the "Synchronize tags" option in an extended recipe view. This means the recipe data 
record values cannot be changed outside the recipe view in the configured I/O fields. 

The following system functions have no effect if you have cleared the "Synchronize tags" option.

● LoadDataRecord

● SaveDataRecord

● SetDataRecordTagsToPLC

● GetDataRecordTagsFromPLC

Engineering System
8.3 Recipes
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8.4 Screens and Screen Objects

Contents
Screen and screen object configuring information which could not be included in the manual 
or Online Help.

OLE server
 

 Note

We recommend you use "Create new graphic from file" to create graphics. Use "Create new 
graphic from OLE object" only for those file formats that are not supported.

 

 

OLE servers released for use in WinCC flexible:   

 Windows XP Windows 7
Adobe Photoshop CS3 Yes 1) No
AutoSketch 9 No No
Corel Designer 12 Yes Yes
Corel Draw X3 Yes Yes
Corel Photo Paint X3 Yes Yes
Corel Paint Shop Pro Photo X2 No No
Microsoft Office 2007 Yes Yes
Microsoft Paint 5.1 Yes No
Microsoft Paint 6.0 No Yes
Visio 2003 Yes No
Visio 2007 Yes 2) Yes 2)

Paint Shop Pro 9 Yes 3) No

 

Engineering System
8.4 Screens and Screen Objects
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1) "Create new graphic from OLE file" - "Create from file" not available
2) "Create new graphic from OLE file" - "Create from file" not available

Proceed as follows instead:
1. Start the graphics program.
2. Create the graphic with the graphics program and save the graphic on your data carrier.
3. Create a graphic display in WinCC flexible.
4. In WinCC flexible, click the "General" group in the Properties window of the Graphic view.
5. Click "Create New Graphic from OLE Object".
6. From the "Insert object" dialog box, select "Create from file." Click "Browse..." Use the 

dialog to help you navigate to the folder in which the graphic is saved.
3) The error message "Server overload" may be displayed at initial start.

Remedy:
Open and close the graphics program standalone. Repeat insertion of graphic in 
WinCC flexible.

Special considerations regarding OLE graphics
If you edit an OLE graphic with Microsoft Paint, you may not change the file format with the 
"Save as" command before returning the OLE graphic to WinCC flexible.

The entry "Bitmap Image" is no longer available under Windows 7. Use "Paintbrush Picture" 
instead.

Inserting OLE object
When you create a new graphic from an OLE object, the dialog "OLE-Graphic edit process" 
will open in the background.

The dialog will remain active in the background as long as the dialog "Insert object" stays open. 

The dialog "OLE-Graphic edit process" will shut down automatically under Windows XP as 
soon as you close the dialog "Insert object."

It may occur under Windows 7 that the dialog "OLE-Graphic edit process" does not close 
automatically.

Click Back in WinCC flexible to close the dialog, to return to WinCC flexible and to shut down 
the OLE server.

OLE object under Windows 7
Do not use an OLE object of the type "Package" under Microsoft Windows 7.   

GIF graphics with transparent components from WinCC flexible 2005 SP1     
GIF graphics with transparent components that were configured in a WinCC flexible project 
2005 SP1 or SP1 HF1, may be displayed differently when they have been opened in the current 
version. 

Remedy: Integrate the original graphics again into the current project.

Engineering System
8.4 Screens and Screen Objects

Readme
32 System Manual, 11/2011, Printout of the Online Help



Error message "Server is fully utilized" for Paint Shop Pro 9 object
The action will be aborted when you configure an OLE graphic from Paint Shop Pro 9 in WinCC 
flexible ("Create new graphic from OLE object" --> "New").

Remedy: Open and close "Paint Shop Pro 9" standalone. Repeat this step.

Array elements of faceplates
Do not assign any array element or multiplex tag connected to an array to the property of a 
screen object if the following conditions apply:

● The property is configured as system function parameter in a faceplate.

● You have configured system functions or scripts for events of the property in a faceplate.

Text lists with variables in faceplates
Configure text lists with variables in a faceplate. If you supply the variables with values via a 
dynamic interface, you may not interconnect them with an array element.

Rotation of faceplate instances
The rotation of faceplate instances will not be supported if you configure the faceplate type to 
"fixed size" or "same aspect ratio." 

Flipping of faceplate instances
Flipping of faceplate instances is not supported.

Key-operated switch as direct key
If the direct key tag is connected to a process and communication is up, the actual value is 
transferred from the PLC to the tag. The tag that contains the current position of the key is 
overwritten by this process. It may happen that the key switch tag no longer reflects the current 
value of the key-operated switch, for example, if the Mobile Panel is switched off while the key 
is being turned.
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8.5 Alarm system

Contents
Information on alarm programming not included in the manual or Online Help.
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8.6 User Administration

Contents
Information on user administration not included in the manual or Online Help.

Simulation with export of user data
During a simulation you can also test the exporting of user data. After a completed simulation, 
delete the export file with the password list on the PC. This setup ensures that nobody has 
unauthorized access to the passwords.

Importing password lists
When password lists are imported, the passwords are not checked for conformity to the rules 
set up in the Engineering System.

If the users are exported from a project where passwords rules are not set, they can be 
imported into a project that has password rules. It is therefore possible to have users without 
special characters in their password in a project that requires special characters.

"Login using password exclusively" option
The option is activated as default for new projects in the following HMI devices:

● OP 77A

● OP 77B

● TP 177B 4"color PN/DP

● KTP400 Basic mono PN

● KTP400 Basic mono PN Portrait

The default setting for the option "Login using password exclusively" is deactivated for all other 
HMI devices. When you migrate existing projects to WinCC flexible 2008, the option is always 
deactivated even for the HMI devices listed above.

Deleting users with active "group number hierarchy"
The active "Group number hierarchy" check box allows administrators to manage only the 
users assigned a group number which is less than or equal to that of the administrator.

If WinCC flexible does not assign the highest group number for the default "Admin" user, then 
you will no longer be able to manage user groups in Runtime.

Example: 

- user configured with administrator rights of group 20

- user configured with user rights of group 10

- default "admin" user created by WinCC flexible of group 9

Engineering System
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If you delete the user with group 20, you can no longer edit the user of group 10. You will no 
longer be able to assign users to groups 10 and 20.

The reason is the lower group number. The remaining user with "administrator rights" of group 
9 is ranked lower than the user with "user rights" of group 10.

SIMATIC Logon
If you use SIMATIC Logon, make sure that the names of the Windows user groups and users 
do not contain the '/' and '\' characters.

Engineering System
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8.7 System Functions and Scripting

Contents
Information on script programming not included in the manual or Online Help.

"NotifyUserAction" system function
FDA guidelines stipulate that the tags for the following parameters must always contain a value 
in Runtime:

● Category

● Object name

● Description

System function "AdjustContrast"
The system function "AdjustContrast" is only supported by Basic Panel KTP 600 Basic Mono 
PN and KTP 400 Basic Mono PN. 

"CallText" system function in faceplates
The system function "CallText" is not supported in faceplates.

System function "ClearDataRecordMemory"
The "ClearDataRecordMemory" system function can only be used to delete recipe data 
records. It cannot be used to delete recipes.
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8.8 Import and export

Contents
Information on import and export functions not included in the manual or Online Help.

Importing and exporting SIMOTION tags
SIMOTION tags can neither be imported nor exported. WinCC flexible does not support imports 
and exports with symbolic addressing. SIMOTION only allows symbolic addressing.
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Communication 9
9.1 General information

Contents
Information on communication drivers not included in the manual or Online Help.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, such as PROFINET IO, HTTP, Sm@rtAccess, 
Sm@rtService and OPC, it is the end user who is responsible for the security of his data 
network. The proper functioning of the device cannot be guaranteed in all circumstances; 
targeted attacks, for example, can lead to an overloading of the device.     

 

Connecting cable order numbers not up-to-date
The online help contains order numbers for connecting cables that have been discontinued. 

For detailed information, refer to Siemens Online Support under comment number: 26556941 
(http://support.automation.siemens.com/WW/view/en/23486974) 

You will find the order numbers for connecting cables in the catalog under "HMI accessories".

Diagnostic Repeaters on PROFIBUS
Communication at OP 73micro, TP 177micro, OP 73, OP 77A and TP 177A HMI devices may 
be disrupted when a diagnostic repeater and an HMI device are operated on the same 
PROFIBUS network, and the diagnostic repeater is used for line diagnostics.     

Changing the CPU type in STEP 7
If you change the CPU type in STEP 7, the connection between symbols and this CPU is 
disconnected in WinCC flexible.

Select "Reconnect" in order to reconnect the symbols to the CPU.

Modification of the baud rate at MPI/DP networks   
Applies for the following devices:

● MP 277

● Mobile Panel 277

● MP 377
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If you modify the baud rate in the MPI/DP network, the HMI device has to be rebooted.

PC adapter MPI/PROFIBUS aborts the connection at MP 377
The PC adapter MPI/PROFIBUS (6ES7-972-0CA23-0XA0) is not approved for the transfer of 
images or projects to an MP 377.

PROFINET IO direct keys
You must always use the new GSDML file in HW Config of the STEP 7 project if you are using 
the current image for the HMI devices. You can change the version of the GSDML file 
accordingly by editing the properties of the HMI device in HW Config. 

The new features in PROFINET IO (e.g. the topology editor) require an IO controller (S7CPU) 
of a more recent design. HW Config informs you of whether or not your IO controller supports 
the new features by generating a corresponding alarm once you have assigned the HMI device 
to the IO controller. You need to upgrade your IO controller in this case.

Communication via OPC
OPC Material is used in OPC XML Gateway. OPC Foundation homepage 
www.opcfoundation.org

An OPC Server is installed on an HMI device and is used to communicate with a PLC.

If you are using a tag of  "String" data type to access an OPC Server tag of  "String" data type 
and the string length in the PLC exceeds the tag "Length", the "Value change" event configured 
at this tag is triggered persistently in Runtime, regardless of whether or not the string in the 
PLC has changed.

In this case, you should carefully check the string length in the PLC and configure a tag of 
"String" data type and appropriate "Length".

OPC: Using the HMI device under Windows 7

HMI device Data exchange 
over

Operating system OPC server OPC client

PC, Panel PC DCOM Windows XP
Windows 7

OPC DA server OPC DA client

OPC: OPC Item Browser quantity structure
You should not configure more than 1000 tags in the OPC Item Browser.

OP 73micro, OP 73, OP 77A, TP 177A, TP 177micro and Basic Panels: Updating of tags
Tags with a configured cycle time of 100 ms will usually be updated after 120 ms. 

Communication
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OP 77A, TP 177A and Basic Panels: Drivers for non-Siemens PLCs
Arrays with more than 100 data words will not be supported for connections to "Modicon 
Modbus" and "Allen-Bradley DF1."

Use of PROFINET IO with Panel HMI devices
When you use PROFINET IO to connect the direct keys and LEDs of HMI devices with the 
PLC, you can set an offset for the address range of the inputs and outputs during configuration 
in HW Config.

The following restriction applies when you use a PROFINET IO capable CPU of the 400 series 
in connection with one of the HMI devices listed below:

The offset for the start of the address range of the inputs may not exceed the offset for the 
start of the address range of the outputs.

The limitation applies to the following HMI devices:

● OP 177B

● OP 277

● Mobile Panel 177

To configure the address parameters, open the PLC with the CPU of the 400 series in 
HW Config. Select the HMI device connected with PROFINET IO in the station window of 
HW Config. The lower area of the station window shows a table in detailed view with the 
properties of the HMI device. Select the table row with the addresses of the HMI device and 
open the object properties with the shortcut menu.

Select the "Addresses" tab in the "Object Properties" dialog. Configure the offset for the inputs 
under "Inputs > Start." Configure the offset for the outputs under "Outputs > Start."

Simulation with process connection
Simulation with process connection is not possible with SIMATIC Manager V5.3 for the 
following HMI devices:

● TP 177A

● KTP1000 Basic DP

● KTP600 Basic color DP

Communication problems with PC/PPI cable and STEP 7-Micro/WIN 
If you install WinCC flexible and STEP 7-Micro/WIN, problems with the communication via the 
PC/PPI cable may occur, irrespective of the sequence of installation.

If you want to establish communication using the PC/PPI cable, proceed as follows:

Removing the PC/PPI cable driver

1. Select the "Set PG/PC interface" command in the "Start > Settings > Control Panel" menu.

2. In the "Interface" area, click "Select".

3. In the "Installed" area, select "PC/PPI cable".
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4. Click "Remove".
The driver is now removed.

5. Install the "PC/PPI cable" again.

PC adapter MPI/PROFIBUS for PCs with dual-core processors   
The PC adapter MPI/PROFIBUS (6ES7-972-0CA23-0XA0) is not approved for communication 
of PCs with dual-core processors.

TS Adapter IE and TS Adapter II in MP 370 and MP 377   
An OS update via "TS Adapter II" and "TS Adapter IE" has not been released for the following 
HMI devices:

● MP 370

● MP 377

Special features of a connection with the Mitsubishi PG protocol and protocol 4
There are different limits for the address ranges for the CPUs of different series. Refer to the 
Mitsubishi Computer Link manuals to determine the appropriate limits. In the Q series, it is 
only possible to address up to 8191 in the M and D area.     

OP 73micro, OP 73 and OP 77A, TP 177 micro, TP 177 A and Basic Panels: Parallel communication 
for projects integrated in STEP 7

Note the following for projects integrated in STEP 7:

● Parallel communication via MPI/DP and Ethernet is not permitted.

● Only one connection is permitted.

Allen-Bradley: Communication via DH485 protocol
Different from the description in the Online Help, you may set up the following protocol 
parameters:

● Data bits:"8 bits"

● Parity: "even"

● Stop bits:1 bit 

WinAC RTX
WinCC flexible Runtime is installed. It is possibly necessary to manually reinsert a CP that was 
configured for WinAC RTX as IF module before you run WinAC RTX. 

 

Communication
9.1 General information

Readme
42 System Manual, 11/2011, Printout of the Online Help



9.2 OPC

Special features of OPC communication
Requirements: An OPC Server is installed on an HMI device and is used to communicate with 
a PLC.

When using a tag of the data type "String" to access an OPC Server tag of data type "String" 
and the string length in the PLC exceeds the tag "Length", the Runtime program continually 
triggers the "Value change" event configured at this tag, regardless of whether or not the string 
in the PLC has changed.

In this case, you should carefully check the string length in the PLC and configure a tag of 
"String" data type and appropriate "Length".

Inconsistent OPC tag values in the PLC and HMI device
Requirements: A tag "x" is configured in an I/O field on the HMI device, for example, and is 
synchronized automatically with the corresponding tag "x" on the PLC by way of OPC server.

After an operator has entered a new value in the I/O field, e.g."1", the value of tag "x" in the 
PLC is synchronized by changing it from "0" to "1" (Write), for example. In reverse direction, 
the HMI device reads the tag value from the PLC (Read) in asynchronous mode (e.g., at 
intervals of 500 ms, as configured in the tag.) However, the HMI device is only updated after 
the value has changed (Read OnChange).
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A value change is not made available to the OPC server if the PLC or a different HMI device 
now reset the value of tag "x" to its old "0" value within the read cycle, i.e. "0 -> 1- > 0". The 
value of tag "x" is now set to "1"on the HMI device and to "0" on the PLC.

 

 CAUTION

Inconsistent OPC tag values in the PLC and the HMI device:

To avoid concurrent write access of other communication nodes and of the PLC itself to the 
same configured tag in the PLC, e.g., set up separate read and write tags on the HMI device.

 

Rapid successive changes of an OPC tag value on the HMI device will generate incorrect values on 
the PLC:

A tag "x" is configured on the HMI device and is synchronized automatically with the 
corresponding tag "x" on the PLC by way of OPC server. 

The following example illustrates the issue. Tag "x" is read by a system function (Read); "f" is 
changed and the result is written to the tag (Write).

Example of system functions "f":

IncrementValue(), SetBitWhileKeyPressed() etc.

Events that may trigger inconsistent values on the PLC:

● Tag "x" is changed twice in rapid succession on the HMI device, e.g. by means of system 
function "IncrementValue()" 0 -> 1 -> 2.

● Following these transitions, the "DecrementValue()" f(x) =x - 1 system function is called 
immediately on the HMI device.

● The HMI device receives the value changes "1" and "2" with delay.

If the value change "1" is received before Read (a), the system function decrements the 
incorrect value "1" to "0" and writes it back to the PLC. The value "2" was already saved to the 
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PLC. The system function returns an effect other than expected by the operator.
Examples: 

● A value is decremented twice.

● A bit is no longer reset.

● A value is not incremented.

● Situations in which the value change to "2" is possibly ignored (possible alternatives):

● The system function has already read the incorrect value "1" (b).

● The HMI device discards the changed value "2" because the write operation is currently 
active (c).

● The changed value "2" is overwritten again with the incorrectly changed value "0" on 
completion of the write operation (d).

 

 
 CAUTION

Avoid rapid successive changes to an OPC tag value. Scenarios which may result in the 
problem described above:

• Jogging mode by pressing a control element several times, for example, by means of 
rapid successive execution of the "IncrementValue" function as shown earlier in the 
example.

• Function list in which the same tag was changed several times.

• Script for 1 to 10 x = x + 1, for example

• Combination derived from the three scenarios

Avoid the problem described earlier by setting up an interval between rapid successive 
changes of the tag value of at least twice the duration of the read cycle of this tag. This 
minimum value also depends on the OPC server implementation and on server load.
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Runtime 10
10.1 General information

Contents
General information that could not be included in the manual or Online Help.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, such as PROFINET IO, HTTP, Sm@rtAccess, 
Sm@rtService and OPC, it is the end user who is responsible for the security of his data 
network. The proper functioning of the device cannot be guaranteed in all circumstances; 
targeted attacks, for example, can lead to an overloading of the device.

 

Internal flash memory on Windows CE devices
Cyclic write access to internal flash memory is not allowed, because this reduces the useful 
life of flash memory and of the HMI device.     

You should preferably use external memory cards, in order to prolong the useful life of your 
device, and to benefit from their higher performance in saving data records and data logging.

Maximum number of files in the root directory of memory cards or internal flash
The capacity of the root directory on a memory card or internal flash memory is limited to 256 
files. This limit does not apply to subdirectories.       

Data loss in archives
In order to prevent loss of data, always terminate the Runtime software before switching off 
the voltage supply. Close the project by using the control element to which the "StopRuntime" 
function was assigned in your configuration.

Alternatively, you use the uninterruptible power supply (UPS) to ensure a controlled shutdown 
of the HMI device.

Communication via OPC
OPC Material is used in WinCC flexible Runtime. OPC Foundation homepage 

www.opcfoundation.org
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Integrated firewall of the antivirus tools
Authorize access to the following locations in the firewall to work without problems in WinCC 
flexible Runtime:

● [Installation directory of the Automation License Manager] almapp\almappx.exe

● %CommonProgramFiles%\Siemens\SWS\almsrv\almsrvx.exe

High CPU load
For fault-free operation, disable the "Norton Auto Protect" option in the "PC Norton Protection 
Center". The "Norton Auto Protect" option may result in a high CPU load. The high CPU load 
may block execution of other processes.

Backup
Runtime must be terminated before you run a backup.

Windows 7: Changing system time in Runtime
A Windows user who wishes to set the system time of the PC via Runtime, for example, by 
means of a date/time field or a controller job, needs to have the corresponding access rights.

You assign these rights in the "Security Configuration Manager".

The user must be entered under "Security Settings > Local policies > User rights > Change 
the system time". Alternatively, the user is a member of the "Siemens TIA Engineer" user group.

Runtime
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Transfer 11
Contents

Notes on transfer that could not be included in the manual or online help.
 

 NOTICE

Automatic termination of Runtime

If the automatic transfer has been activated on the HMI device and a transfer is initiated on 
the configuration PC, the currently active project is terminated automatically. 

The HMI device then automatically switches to "Transfer" mode.

After the commissioning phase, deactivate the automatic transfer so that the HMI device 
cannot be inadvertently switched to transfer mode.

The transfer mode may trigger unwanted responses in the system.

To restrict access to the transfer settings and prevent unauthorized modification, assign a 
password in the Control Panel.

 

Serial transfer via RS-485 interface
When an HMI device is communicating with the PLC via the RS-485 interface and MPI or 
PROFIBUS, the "Remote Control" box must be cleared (disabled) for serial transfer.

Clear the "Remote Control" check box under "Channel" tab in the "Transfer Settings" dialog. 

Manually select serial transfer.

Remote transfer via serial interface
Remote transfer of the project is not possible if you have not configured a connection to a PLC 
in the WinCC flexible project. The following options are available in order to carry out the 
transfer:

● Create a connection via MPI or DP interface in the WinCC flexible project and switch to 
"Online: Off". Remote transfer is possible with this setting.

● Alternatively stop Runtime on the HMI device and start the transfer manually.

Transfer via Ethernet connection with router
Ensure that the internal transfer buffer of the router exceeds 1 Kbyte if an Ethernet connection 
with a router is used for transferring. In the case of routers with a transfer buffer < 1 Kbyte 
message splitting can result in message corruption and thus in the transfer being aborted.
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Execute a "Rebuild all" before transferring data to the HMI device   
Recompile the entire project by executing the "Rebuild all" command before releasing your 
project to the production process. 

It is also advisable to execute a "Rebuild all..." command at suitable intervals to reduce the 
time required for compiling delta data in current engineering sessions.

Execute a full compilation by selecting the "Project > Compiler > Rebuild all..." menu command. 

If you have configured several HMI devices, the "Select HMI devices for generation" dialog 
will open after you have executed the "Rebuild all" command. 

Select the HMI devices to be generated from this dialog. Multiple selection is possible.

Transfer canceled by user
It may take up to 5 minutes to cancel a transfer. No other transfer is possible during this period. 
You will receive the following message in this case: "A transfer is already in progress. Please 
wait until the first transfer has finished.". 

Transfer can be continued as usual after expiration of this waiting period. 

Transfer to an HMI device with WinAC MP
If you transfer a project to an HMI device operating with the WinAC MP PLC, then use the 
"Ethernet" channel instead of "S7/Ethernet".

Project transfer using the Ethernet ISO profile
The ISO profile of the Ethernet protocol is not supported for the project transfer.

Indirect transfer of a project: Recipes
If you transfer a project with recipes, you may see the following error message in some rare 
cases.

"Error upon accessing file (Host): File '<Pack&Go_Folder>\PDATA.recipe.zip' not found!"

Remedy:
1. Reboot the HMI device.

2. Copy the following files from "<Pack&Go_Folder>\Transfer\" to "<Pack&Go_Folder>\Extern
\VersionStore\".
mfc71.dll
mfc71u.dll
msvcp71.dll
msvcr71.dll

3. Repeat the transfer.

Transfer
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HMI device with PROFINET: Communication error during connection establishment
Note the following specifications to avoid a communication error during establishment of 
connection between HMI device and configuration PC:

● The subnet mask of the configuration PC and the HMI device must be the same.

● The IP network address range must match the used subnet mask.

● The network address of the configuration PC and the HMI device must be the same. They 
need to have a unique host address, such as 192.168.0.1 and 192.168.0.2.

● A default gateway is required if the network address is different, such as 192.168.x.y and 
192.160.x.y.

Routing via SIMOTION CPU 4.1.2
The transfer of the configuration via S7 Ethernet does not work in case of routing via SIMOTION 
CPU 4.1.2. 

MPI / DP download is not functioning:
If CP 5603 is directly in the WinLC RTX EC and is plugged into IF2, no PROFIBUS transfer is 
possible. In this case, the CP belongs solely to the CPU. 

If CP 5613 A2 is configured directly on an index in the station editor, PROFIBUS transfer to 
WinCC flexible RT is possible. Remote transfer is not possible in this case, because the remote 
functionality of the RT loader has no connection to the Softbus interface of the station editor. 
The RT loader must be manually switched to transfer mode. 

If the CP is not plugged in the station editor and is also not assigned to WinLC, PROFIBUS 
transfer to WinCC flexible RT is possible. The access point must be provided via the PG/PC 
interface in this case. 

For remote transfer, it is important to ensure that the project also has a valid PROFIBUS 
connection because the RT will overwrite the parameters of the PG/PC interface at startup. 

If no connection is configured, PROFIBUS and remote access are inactive. 

Transfer
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WinCC flexible integrated 12
12.1 Integration in SIMOTION

Contents
information on integrated operation in SIMOTION not included in the manual or Online Help.

Enabling the integration of WinCC flexible in SIMOTION SCOUT
Integration of WinCC flexible 2008 has been approved for the following versions of 
SIMOTION SCOUT.

● Windows XP (32-bit): 
WinCC flexible 2008 SP3 with STEP7 5.4 SP5 and SIMOTION Scout 4.1 SP5

● Windows XP and Windows 7 (32-bit): 
WinCC flexible 2008 SP3 with STEP7 5.5 SP1 and SIMOTION Scout 4.2 SP1

● Windows XP (32-bit) and Windows 7 (32-bit and 64-bit):  
WinCC flexible 2008 SP3 with STEP7 5.5 SP2 and SIMOTION Scout 4.3 

Proceed as follows to enable the integration of WinCC flexible in SIMOTION SCOUT:

1. Select "Settings" from the "Options" menu.

2. Click the "WinCC flexible" tab.

3. Enable the option "Use and display WinCC flexible component."

AxisMotor screen
There is no length information in the "ShowAxisMotor" screen for "Backlash compensation".

Assign start value 1 for the created tag (Tag\C230\Axis_1\AxisMode).
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12.2 Integration in STEP 7

Contents
Information on integrated operation in STEP 7 not included in the manual or Online Help.

Interconnecting STEP 7 symbols in new STEP 7 projects
The interconnection of STEP 7 symbols with WinCC flexible tags will cause problems, if the 
corresponding STEP 7 project was created while another WinCC flexible project was still open.

Close all WinCC flexible projects before you create a new STEP 7 project.  

Symbol server
Extensive changes in your STEP 7 project may cause problems at the symbol server. Close 
all WinCC flexible projects before you make any substantial changes in your STEP 7 project.   

This is valid in particular:

● If changes are to be made to station names, CPU names or S7 program names.

● If one or more S7 stations are to be copied to a S7 project in SIMATIC Manager -stations 
or deleted from an S7 project.

Wrongly labeled S7 symbols on tags
If all S7 symbols on tags are labeled as faulty (orange marking of the "Symbol" cell) after a 
HMI project integrated in STEP 7 has been opened, it can be helpful to save the entire S7 
project under a different name in the SIMATIC Manager with the help of "Save as" (with 
reorganization option enabled).

Multiple sessions with integrated projects
Multiple WinCC°flexible sessions for STEP°7 projects may cause problems in the 
synchronization of data between STEP 7 and WinCC flexible, for example, when setting online 
data, or saving data. To avoid such problems, make sure you run a WinCC flexible session 
only for one STEP 7 project.

Also avoid opening several WinCC flexible instances from STEP 7.   

SIMATIC Manager: "PLC > Compile and Download Objects"
The use of the "PLC > Compile and Download Objects" function of SIMATIC Manager may 
cause problems. If you encounter problems, activate only one SIMATIC HMI station in the 
selection table each time you compile.  

Copying integrated connections  
If you copy integrated connections by using copy-and-paste, the "Station", "Partner" and 
"Node" columns remain empty. Drag the columns across manually.

WinCC flexible integrated
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Deleting an HMI device
By deleting an HMI device in WinCC flexible (except WinCC flexible Runtime), you remove 
the entire HMI station from SIMATIC Manager, including all of its sublevel components such 
as WinAC MP.

Integrated project with CFC components and ALARM_S alarms
The following requirements have to be met to process a project that includes CFC-specific 
components and ALARM_S alarms:

● The engineering tool "CFC" has to be installed

or

● STEP7 V5.4 SP4 has been installed

Incorrect representation of (HMI) PC stations
The following options are available for restoring a (HMI) PC station that can no longer be 
correctly compiled in HW Config:

Backup copy of the configuration is available
1. Delete the corrupt (HMI) PC station in the SIMATIC Manager.

2. Copy the backup station data to the SIMATIC Manager.

Backup copy of the configuration is not available
1. Close HW Config.

2. If an error has occurred, you will see two WinCC flexible Runtimes on the target station in 
the SIMATIC Manager. Delete the lower WinCC flexible Runtime in the SIMATIC Manager.

3. Create a new (HMI) PC station corresponding to the old target station in the SIMATIC 
Manager.

4. A WinCC flexible Runtime is created by default when a new HMI PC station (such as PC 
877) is created. Delete this WinCC flexible Runtime.

5. In HW Config, open the new and the corrupt (HMI) PC station.

6. Copy the corrupt station in HW Config. This includes: WinCC flexible Runtime, CPU, 
software components and interface cards.

7. Compile the newly created and completely configured (HMI) PC station in HW Config.

8. Close HW Config.

9. Delete the corrupt station in the SIMATIC Manager.

10.Reconnect the previously used network connection for the (HMI) PC station via NetPro or 
WinCC flexible 2008.

Language settings when creating an HMI station
If problems occur when creating an HMI station from SIMATIC Manager, check the following:

WinCC flexible integrated
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The language selected under "Language for programs that do not support Unicode" must 
match the selected user interface language.

"Language for programs that do not support Unicode" can be found under: 

Start > Settings > Control Panel > Regional and Language Options > Advanced.   

Configure an HMI device as a DP slave without address
If you have configured an HMI device as DP slave in a DP master system, ensure that this 
HMI device is located in an HMI station. Otherwise, you will not be able to assign an address. 

See also
General Information (Page 25)
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Options 13
13.1 Sm@rtAccess, Sm@rtService

Contents
Notes on the Sm@rtAccess and Sm@rtService options not included in the manual or Online 
Help.

 

 CAUTION

Ethernet communication

The end user is himself responsible for the security of his data network; the proper functioning 
of the data network cannot be guaranteed in all circumstances, for example in the case of 
target attacks leading to an overloading of the device.

 

Operation via Sm@rtClient for key devices after an update to WinCC flexible 2005 SP1
Due to the harmonization of key codes, the current HMI device versions of OP 170B and 
OP 177B before WinCC flexible 2005 SP1 are no longer compatible with previous versions of 
these devices as of WinCC flexible 2005 SP1. If you use one of these devices as a 
Sm@rtServer and want to carry out keyboard operations at a connected Sm@rtClient, you 
have to check whether the correct keyboard commands are transmitted. If the keyboard 
commands are incorrect, update the HMI-device version of the HMI devices involved.

Transferring of key codes of F-keys and K-keys using Sm@rtClient to PC-based key devices
The F and K key codes are only transferred reliably via Sm@rtClient to the Sm@rtServer if 
the WinCC hotkey function is activated. Open the "SIMATIC Key Tools" via "START > Settings 
> Control Panel" and activate the WinCC Hotkey function by clicking the "Start" button.

WinAC RTX and Sm@rtServer on a Panel PC 477B
When operating a WinAC RTX and the WinCC flexible Sm@rtServer on a Panel PC 477B at 
the same time, only two simultaneously connected Sm@rtClients are permitted.

Sm@rtServer and Sm@rtClient in conjunction with a Panel PC
If you access a Multi Panel as Sm@rtServer with a Panel PC as Sm@rtClient, you will have 
to disable the function "WinCC hotkey" in the KeyTools. 
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Simultaneous access via Sm@rtClient and RDP
You have the following options for access to an S7-mEC with WinCC flexible Runtime or a PC 
with WinCC flexible Runtime:

● Using Virtual Network Computing (VNC) on the Sm@rtServer

● Using the Remote Desktop Protocol (RDP) from Microsoft

Due to system restrictions, simultaneous access with VNC and RDP is not possible.

Scenario: 

An S7-mEC is used as Sm@rtServer. Three Sm@rtClients access the Sm@rtServer. As soon 
as a PC accesses the S7-mEC using RDP, the connections to the Sm@rtClients are 
terminated.

Default pages for the Integrated Web Server
The default pages for the Integrated Web Server of PC Runtime are available in "C:\Documents 
and Settings\All Users\Application Data\Siemens\HmiRTm\MiniWeb1.3.2\WebContent".

Automatic scaling
No automatic scaling takes place with some relationships of server resolutions to client 
resolutions. As an alternative, disable automatic scaling or change the resolution of server or 
client.      

Settings on the HMI device
The "Blank screen on client connection" setting is not available in the "Server" tab of the 
"Sm@rtServer: Current User Properties" dialog.   

Listening mode of the Sm@rtClient application
The port must be enabled in the firewall to use the "Listening mode" function.

E-mail notification
For e-mail notification, you can configure a sender name that will be specified in the e-mail. 
Delete the entry if the function is not supported by the SMTP server. For more information 
contact your service provider.

Deleting the sender name:

● In the WinCC flexible project: Editor "Device Settings " > Name of the sender 

● On the HMI device: Control Panel > WinCC Internet Settings > "Email" tab > Name of sender
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On-screen keyboard
● The on-screen keyboard on the client is only available if the on-screen keyboard is also 

enabled on the server.

Sending e-mails
● You may only send 50 e-mails at one time.

No S7-MEC connection via Sm@rtAccess
You need an EM PC module if using Sm@rtAccess on on EC31. Use the Remote Desktop 
Protocol (RDP) as an alternative.
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13.2 ProAgent

Contents
Information on the operation of ProAgent not included in the manual or Online Help.

ProAgent upon faulty installation of STEP 7"
If ProAgent is installed on a PC on which no STEP 7 is installed, the "Diagnostics" entry is not 
available in the project tree. It is therefore not possible to select units.

The ProAgent views can be configured on this PC. When the project is generated, however 
the following message appears "Warning: Internal WARNING (Detail: screen element ... was 
created by GeneratorHmiScreen ... - Object type: SCREEN_ITEM)". In Runtime, no ProAgent 
views appear on this PC.   

Using the "Compile and Download Objects" function 
If you carry out a change in PDiag, S7-Graph or S7-HighGraph, it may be necessary to carry 
out a consistency check in the existing WinCC flexible projects, in order to ensure that the 
change has been transferred correctly to the HMI devices by means of the "Compile and 
Download Objects" function.       

Number of devices in the project
It is advisable to manage only one device per HMI project when using ProAgent.

Step sequence screen
Each step sequence screen can handle a maximum of 128 steps and 128 transition.

Asian languages
The ProAgent option has not been released for Asian languages.   
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13.3 ChangeControl

Contents
Information on ChangeControl option that could not be included in the manual or Online Help.

Editors of the ChangeControl option
The WinCC flexible option WinCC flexible /ChangeControl is used for versioning of 
configuration data and to track changes in the configuration. The respective editors "Project 
versions" and "Change log" are located in the project window under version management. 

Project versions on network drives
Project version management is not currently supported on network drives. 
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HMI devices 14
14.1 General information

Contents
Information on special features of the HMI devices not included in the manual or Online Help.

Multi-key operation
Multi-key operation may initiate unwanted actions:         

● Do not press more than two function keys simultaneously when using a keyboard device.

● Do not press more than one button at any given time when using touch devices, standard 
PCs or a panel PCs.

Connection between Windows CE and Windows XP
If you want to use a HMI device with Windows CE operating system to access a computer 
running Windows XP operating system, for example: to print via Windows XP or to open a 
folder there, you have to disable simple file sharing in Windows XP. To deactivate simple file 
sharing, open the Windows Explorer under Windows XP. In the menu bar, select "Tools > 
Folder Options". The "Folder Options" dialog box opens. Click the "View" tab and clear the 
"Simple File Sharing" check box in the "Advanced Settings" window. Click the "OK" button to 
accept the settings.

Converting daylight savings time and standard (winter) time
The HMI device does not automatically convert from daylight savings time to standard (winter) 
time. Use the in Control Panel to define whether daylight savings time or standard time is 
currently in effect. In order to convert from winter to summer time, activate the "Daylight savings 
time currently in effect" check box in the "Date/Time Properties" dialog box. The clock is 
converted to daylight saving time after you confirmed the change and closed the dialog. 
Deactivate this check box if you want to change to standard (winter) time. 

You can set daylight saving time with the system function "SetDaylightSaving."

SIMATIC Panel PC 477, PC 577, PC 677, PC 877: Distorted display of icons
If you open projects in WinCC flexible that were created with a version of WinCC flexible 
2005 SP1, the icons may be displayed distorted. The icon size of the HMI devices listed above 
has been adapted in WinCC flexible 2007. Remedy: Open the "Device Settings" editor and 
adjust the size of the icons manually to the value of WinCC flexible 2005 SP1 under "User-
defined icon size". The values are listed in the following table.
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HMI device Icon size
(X~Y) 

PC x77 12'' key 80~66
PC x77 15'' key 101~85

Restrictions for logon with access to HTML pages
If you are using the underscore character "_" as part of the HMI device name, logon attempts 
with access to HTML pages of the HMI device may fail.

Do not use the underscore character "_" in the name of HMI devices.

HMI devices with PROFINET IO direct keys
Set up the network configuration of HMI devices which support PROFINET IO direct keys both 
in the Control Panel on the HMI device and in the HW Config editor. The network settings in 
the Control Panel must conform to the settings in HW Config. The "Automatic" mode is set as 
default in both editors. PROFINET IO is only available in "Automatic" or "100 Mbps full duplex" 
mode.

Updating the operating system
It may take up to one minute after you have completed an operating system update to recover 
communication functions using the restored network settings. The PC cannot go online to the 
HMI device via Ethernet until this time has expired. The "Activating connection to restore device 
settings" message is displayed.

SecureMode     
Use SecureMode to protect the Control Panel, the task bar and the desktop of the following 
HMI devices against unauthorized access:

● Mobile Panel 277

● MP 177 6" Touch, MP 277, MP 377

● TP 177B 4"

Enter a password in the "Password Properties" dialog in the Control Panel of the HMI device 
to activate SecureMode. The "secure mode" label is displayed on the desktop.

Enter the set password to enable the operation of the Control Panel, task bar or desktop. The 
label "secure mode" will be hidden.

To reactivate SecureMode, double-click the symbol on the desktop . To deactivate 
SecureMode completely, delete the set password.

Transfer via Teleservice
Transfer via Teleservice must not be interrupted during the data transmission to an HMI device. 
This type of connection is not suited for the transfer of large data volumes, as its transmission 
quality and the stability of the telecommunication line may be insufficient.
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Use Teleservice only to transfer the project to the HMI device. Modem connections are not 
suited for handling return transfers, operating system updates or backup of large data volumes.

"Activate" event: System function with external tag is not executed
HMI devices concerned: Basic Panels, OP73, OP77A, TP177A

The system function is not executed with the following constellation:

● A system function with external tag was configured for the "Activate" event of an object.

● The object as configured as first element in the tab order of the start screen.

The system function is not executed after the start of Runtime because the connection to the 
controller is not yet set up.

Link between panels and enabled Windows network drives
AP01165962, V1.3 SP3

If you are using a panel that is based on Windows CE 5, observe the following rule:

You cannot link panels to enabled Windows network drives if the time difference between the 
PC and the panel is greater than 1 to 2 days.
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14.2 Panels

Contents
Information on special features of the panels which could not be included in the manual or 
online help.

OP 73: Pack&Go with Image version 1.0.0.0
It is not possible to use Pack&Go for an operating system update of the HMI device OP 73 
from Image version 1.0.0.0 to a later version.

Restore process at the OP 177 DP mono     
A superfluous dialog message can occur during the restore process on the OP 177 DP mono. 

Title: "Abort Restore"

Text: "Storage Card couldn't be detected. Try restore again? Insert storage card and Press 
'OK' or abort restore with 'CANCEL'."

Confirm the dialog message with "OK" so that the restore process can be terminated reliably.

OP 277: Adjusting the brightness
It is not possible to adjust the brightness at the OP 277 HMI device. This results in an 
incompatibility to the predecessor model OP 270 or TP 270.     

Simulation in integrated mode with Basic Panels
PLCSIM is not supported for simulation of the Basic Panels with PN interface.     

TP 270: Updating the operating system
After updating the operating system, only the device settings for on-board interfaces will be 
restored. If you are, for example, using an Ethernet CF card for the TP 270, the IP address of 
the corresponding interface may not be restored.

Buttons for Basic Panels, TP 177A and TP 177micro
The buttons are not reset on the TP177A, TP177-micro and Basic Panel HMI devices if you 
assign the Touch Calibration or Clean Screen function to their "Pressed" event. 

OP 73, OP 73micro, OP 77A, TP 177A, TP 177micro and Basic Panels: "ShiftAndMask" system function
You can only execute the "ShiftAndMask" function on the HMI devices OP73, OP73micro, 
OP77A, TP177A, TP177micro, and Basic Panels if the input tag and the output tag are of the 
same data type.
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The "SimulateSystemKey" system function
When the "SimulateSystemKey" function is executed at an input field on Basic Panels, no more 
operation events are processed on the touch screen until input mode is closed with a simulated 
"Enter" or "Esc" key.

Example: 

When you delete the input field with "SimulateSystemKey", you need to enter the "Del key" 
followed by the "Enter key" in the corresponding function list of the function key.   

OP 77A, TP 177A and Basic Panels: Communication partner OMRON
The connection of an HMI device to an OMRON CPU of the OMRON SYSMAC CP1L, CP1H 
and CJ1M series using the Hostlink/Multilink protocol over RS232 has been system tested and 
released by Siemens AG.

A multipoint connection to up to 4 OMRON controllers in an RS422 four-wire multidrop 
configuration can be implemented with communication adapters.     

OP 73micro, OP 73 and OP 77A, TP 177 micro, TP 177 A and Basic Panels: System limits
The following system limits refer to the maximum number per screen:   

● User view: 1

● Trend view: 4

● Alarm view: 20

● Recipe view: 5
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14.3 Multi Panels

Contents
Information on special features of the Multi Panels which could not be included in the manual 
or Online Help.

MP 277: Using USB memory sticks
Only one USB memory stick may be active for saving logs or recipes on the MP 277 HMI 
device. 

MP 377 as Smart Server
There may be noticeable reductions in performance when you use the MP377 as Smart Server 
while using the Media Player or Microsoft Viewer on the panel. We highly recommend that you 
do not make use of such a combination.

PROFINET IO with MP 377
With MP 377, PROFINET IO is activated by default in WinCC flexible 2008 SP1.

If you use PROFIBUS direct keys, deactivate PROFINET IO in the Control Panel.
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14.4 Mobile Panels

Contents
Information on special features of the Mobile Panels which could not be included in the manual 
or online help.

Mobile Panel 177 / 277, with optional backup battery package     
Configure the area "Project ID" area pointer in order to exclude improper operation by means 
of Mobile Panel of a plant which was not configured appropriately.

The system checks at the start of Runtime whether the project ID in the device settings of the 
project matches the value saved to the controller. Runtime is stopped if the value does not 
match.

However, the project ID is not updated if you plug a Mobile Panel with optional battery backup 
package into another terminal box while Runtime is active. Compatibility of the Panel 
configuration with the various control programs can no longer be guaranteed in such a 
situation. 

● Runtime is not stopped.

● Execution of the direct keys DP and PN-IO is not prevented.

● No system event is output to the HMI device.
 

 
 WARNING

Unforeseeable machine reaction to incompatible Panel configuration

Assign all plants which contain one or several terminal boxes for a Mobile Panel different, 
intersystem node and IP addresses at the communication partners, for example, PLCs. 
This prevents access to the wrong communication partner with the same address.

 

Mobile Panel 277: Using USB memory sticks
Only one USB memory stick may be active for saving logs or recipes on the Mobile Panel 
 277.   

Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN: Zone evaluation
The value of the variable zone ID may have the value 0 immediately after the start of Runtime. 
Change the zone (enter or exit) in this case.

Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN: Topology Detection of STEP 7
The topology detection of Step 7 cannot provide values in the online view, since the required 
LLDP service has not yet been specified for wireless in the PROFInet standard.
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Using the direct keys of the Mobile Panel 277:
When using the WinCC flexible 2008 SP1 operating system images for Mobile Panel 277 and 
Mobile Panel 277 IWLAN, you will have to use a new GSDML file in the STEP 7 project in HW 
Config. 

You will have to delete the configured Mobile Panels from HW Config and reinsert them from 
the new HW catalog. 

Discrepancy error in HW diagnostics
The Mobile Panel 277 versions with MLFB 6AV6 645-0CB01-0AX0 and 6AV6 
645-0CA01-0AX0 cause a discrepancy error in the HW diagnostics of an integrated project. 
You can avoid this error by configuring the device with MLFB 6AV6 645-0CC01-0AX0 instead.
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14.5 HMI devices with Windows XPe

Contents
Information on special features of the HMI devices not included in the manual or Online Help.

SIMATIC Panel PC 477 / Microbox 420 with Windows XP embedded (XPe)

Transferring a project
When transferring, you can transfer the compressed source data file along with the compiled 
project file to the HMI device. Sufficient space has to be available on drive D: for the storage 
of the compressed source data. If there is insufficient space available, the transfer is terminated 
with a message that the process was successful. However, the compiled project file is not 
transferred completely so that the Runtime starts with the error message "No configuration 
available. Please initiate transfer". 

Before you restart the transfer, check whether drive D: sufficient space is available.

Printer driver not found
If Windows XP embedded does not have the required driver, use the provided XP Professional 
driver CD or CD2. Further information on installation is provided on the CD.

Restrictions
The following restrictions apply for the SIMATIC Panel PC 477 / Microbox 420 with Windows 
XPe:

● The Allen-Bradley DH485 control driver is not authorized.

● The "Microsoft Script Debugger" and the "Microsoft Script Editor" that is supplied with 
Microsoft Office XP are not authorized and may not be installed.
Use a standard PC to debug your scripts. Further information on debugging can be found 
in the online help under "Working with WinCC flexible > System functions and Runtime 
Scripting > Debugging".

● No logging to the "System" database
If you want to configure logs on Microbox 420, you may not use the "Database / System" 
setting, because the SQL server that is required cannot be run together with the activated 
EWF.

Enhanced Write Filter (EWF)
Enhanced Write Filter (EWF) can be used to write-protect the system partition, for example in 
order to increase the lifetime of the CF card. For additional information, refer to the operating 
instructions.
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Special points for the use of Enhanced Write Filters (EWF)
● When Enhanced Write Filter is activated

– Only the unlimited Single License and Floating License function.

– The Trial licenses do not function.
If you want to use Trial licenses, you have to deactivate the Enhanced Write Filter.

– License keys cannot be transferred to the HMI device.
In order to transfer license keys to the HMI device, proceed as follows:

1. In the Start menu, carry out the "Run..." command. Enter cmd and click the "OK" button. 
The command prompt opens.

2. Enter "ewfmgr c: -commitanddisable" at the command prompt. The write protection for C: 
is switched off and accepts the modified data.

3. Reboot the system in order to accept the changes.

4. Transfer the required license keys to the HMI device.

5. In the Start menu, carry out the "Run..." command. Enter cmd and click the "OK" button.

6. Enter "ewfmgr c: -enable" at the command prompt. The write protection for C: is switched 
on.

7. Reboot the system in order to accept the changes.
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Other information 15
Contents

Further information that could not be included in the manual or Online Help.

WinCC flexible /Archive and WinCC flexible / Audit
The checksums for Log and Audit Trail files were expanded as part of WinCC flexible 2008 
SP2.

S7 routing via Ethernet
S7 routing via Ethernet is not possible with WinCC flexible Runtime.

Updating the operating system
It is not possible to update the operating system via routed connections.

Transferring licenses to a panel on 64-bit operating systems
If you are running a 64-bit operating system and the "Edit > Connect target systems > Connect 
HMI device" menu command is not available in Automation License Manager, open command 
line input and run the following command with administrator rights:

"%WINDIR%\system32\RegSvr32.exe" "%CommonProgramFiles%\siemens\AlmPanelPlugin
\ALMPanelParam.dll"

Use of the mouse wheel in Runtime
The use of the mouse wheel in Runtime is not supported on all panels. 

Transfer via Teleservice
We do not recommend transfer via GPRS, UMTS or GSM, as breakdowns in communication 
may occur.

Chinese characters in Simulation
If you output Chinese strings in a project, it may occur that Chinese characters are shown in 
the script output fields in Simulation, even if the Runtime language "Chinese" is not activated. 
This problem only occurs in Simulation.
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Fast change of wireless networks over SSID
The WLAN Selection Tool (WST) enables fast changing between prepared WLAN 
configurations. If you use several separate WLAN areas in your plant, you can save a 
configuration for each wireless network and change between wireless networks with the WST.
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